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SETTING UP YOUR COMPUTER

INSTALLING PROLOG 4

To Install Prolog begin by going to http://lakewooddata.com/downloads/prolog4/
and downloading Prolog-4-X-X.exe. Alternatively if a flash drive was provided, insert
the flash drive into your computer and run the Prolog-4-X-X.exe. The Install Wizard
will guide you in preparing the software on your computer.

NOTE: It is recommended that your previousNOTE: It is recommended that your previous
versions  of  Prolog  are  uninstalled  prior  toversions  of  Prolog  are  uninstalled  prior  to
installing Prolog 4.installing Prolog 4.
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PROJECTS

 A project contains all of the configuration information for Prolog to work with
your data loggers. Your project also contains previously downloaded data from your
data loggers, and specific software settings for Prolog to use. All of the information
is kept in a base folder for the project. Once Prolog is installed on your computer,
you can load any projects you may have. By clicking on Project, found on the menu
bar, you can select a function from the list below.

PROJECT OPTIONS TAB

New Project – Creates a new project separate from the others.

Change Project – Opens a window to allow switching to another existing 
                Project folder.

Open Folder – Opens a file explorer window to the Lakewood folder on your 
            hard drive.

Pack Project – Saves a project and its settings into a 
  compressed file ending in .ppf that can be easily 
   transferred between computers.

PPF EXAMPLE

Unpack Project – Opens a packed project and creates a file for it 
           in your Lakewood folder.

Options – Make changes or edit project settings.
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SETTING YOUR PROJECT OPTIONS

When you add a new project or run Prolog for the first time, the project options
form will appear. It is a good idea to check your communication options at this time.
Ensure that the communications port and baud rate are set correctly. By default the
Gen 1 loggers have a baud rate of 4800 while the Gen 2 loggers have a baud rate
of  115200.  If  you need to  change your  project  settings  at  any time,  the  project
options form can be accessed by selecting Options from the Project menu at the
top of the program.

PROJECT OPTIONS FORM
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ENTERING YOUR KEY CODE

By default, Prolog software installs as a 30 day trial program. To permanently
unlock the software select Registration from the Help menu. You then need to
enter your user name and key code to unlock the software permanently. Your user
name must be entered exactly as it was given to you.

THE REGISTRATION FORM

NOTE: Your key code is tied to your specificNOTE: Your key code is tied to your specific
user name. They will only unlock the software ifuser name. They will only unlock the software if
they are used together.they are used together.
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CONNECTING YOUR DATALOGGER TO YOUR COMPUTER

GENERATION 1 RX UNIT (LEFT) AND GENERATION 2 TSR UNIT (RIGHT)

Generation 2 Connection
The Generation 2 TSR logger can be connected to any computer with a USB port

using a mini USB cable.

TSR USB CONNECTION
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Generation 1 Connection
The connection from your computer to your RX data logger can be made in a

variety of ways. 

CCUSB Cable

The most common connection to the Gen 1 RX unit is the CCUSB cable. This
can be connected to the com port on the case or directly to the logger inside the
case.

Serial COM Port

Direct serial  connections can be made through Lakewood System's CC-10S
communications cable by plugging into a computer’s serial port

CC-10S COMMUNICATION CABLE
COMPUTER SERIAL PORT
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NOTE:  Not  all  serial  cables  work  withNOTE:  Not  all  serial  cables  work  with
Lakewood data loggers. An incorrect cable couldLakewood data loggers. An incorrect cable could
damage your computer with certain data loggerdamage your computer with certain data logger
configurations.configurations.

USB COM Port

If your computer does not have a serial port, another way to connect directly is
by  using  a  standard  USBA  to  serial  connector.  This  converts  the  serial
communications to USB however it does require additional drivers to operate.

TYPICAL 3RD PARTY USB TO SERIAL CONNECTOR

NOTE: Not all USB to serial converters workNOTE: Not all USB to serial converters work
with Lakewood data loggers.with Lakewood data loggers.
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DOWNLOADING YOUR DATA
After properly installing Prolog 4 and ensuring that the data logger is correctly

connected  to  your  computer.  Prolog  should  automatically  start  up  and  begin
downloading upon detecting the logger. Prolog will also select the correct COM port
and logger generation. If however the logger was not properly detected. The user
can manually select the logger generation and COM port via the drop down menus.

GENERATION SELECT AND COM PORT SELECT DROP DOWN MENUS

If a data logger has been unpowered for some time it is normal for some errors
stating that there was a power interruption and that the clock time is incorrect to
occur.

EXAMPLE OF ERROR THAT COULD OCCUR ON FIRST TIME SETUP

If data needs to be downloaded manually, simply click the Download button
found on the top left of the screen.

DOWNLOAD BUTTON
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WORKING WITH YOUR DATA
Once your download is complete, a graph will appear. Prolog has automatically

created a Lakewood Site File (.lsf). The name of the site file is displayed on the top
bar.  All of the site files are saved in the site folder in your project base folder The
site  file  contains  all  the  important  information  pertaining  to  your  site.  It  includes
current  site readings of your sensors, data logger  settings,  status,  notepad,  and
most importantly your recorded data. To access your site files click on file at the top
of the screen and select open site download. Through the file menu you can also
choose to save the site file or begin a new site download.

THE DOWNLOAD BUTTON 

NOTE: It is important to check the conditionNOTE: It is important to check the condition
of your battery and data logger memory while inof your battery and data logger memory while in
the field.the field.

The  Data button allows you to view and analyze your  data. Your recordings
can be observed as a chart (graph) as well as in tabular form. Your data can also be
transferred to spread sheets, reports, e-mails and other forms of documents.

THE DATA BUTTON

THE DATA SECTION
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ACCESSING YOUR STORED DATA

The site file created by pressing the  Download button can be reopened by
clicking on file at the top of the screen and selecting open site download. Once your
site file is selected and opened you will have the ability to examine your data, use it
in a spread-sheet or paste it into a document. If you do not wish to open the entire
site file and would just like the Data, click on Data at the top of the screen and select
open data. You will also have the option to select new graph or save data as if you
want to rename your data after any edits you have made.

CLICK ON FILE THEN OPEN SITE DOWNLOAD TO LIST YOUR DOWNLOADED AND
PREVIOUSLY SAVED SITE FILES
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WORKING WITH THE GRAPH

ZOOMING BY DRAWING BOXES
You can zoom into a specific region by holding down the left mouse button and

drawing a box from an upper left point on the graph to a lower right point on the
graph and releasing the button.

DRAWING A BOX TO ZOOM THE GRAPH

To return to the original zoomed out state, draw a box from a lower right point to
an upper left point on the graph.

DRAWING A BOX TO ZOOM OUT
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USING THE MOUSE SCROLL WHEEL TO ZOOM AND PAN

The scroll  wheel  of  your  mouse can be used  to  pan and zoom the  graph.
Panning can be achieved by pressing down on the scroll wheel and moving your
mouse around. Turning the wheel up and down allows you to zoom in and out of the
graph respectively.

WORKING WITH A TWO BUTTON MOUSE

If you are using a two button mouse, panning the graph can be accomplished
by right clicking on the graph and selecting the  Use right mouse button to
pan option. To restore your mouse back to the default setting you must first right-
click on the graph, then choose Use middle mouse button to pan.

ANNOTATING THE GRAPH

To add an annotation to the graph, right click on the graph and select  Add
annotation. This will enable you to enter text, which will appear in a box on the
graph. The created annotation box can be moved to a desired location by clicking
and holding down the left  mouse button then placing it.  Annotations can also be
edited or deleted by right clicking on the annotation and selecting the corresponding
option. Annotations and graph zoom states are preserved by saving the entire site
file as a different name. All of the annotations can be cleared by right clicking on the
graph and selecting Delete all annotations.

AN ANNOTATION ON THE GRAPH
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COPYING THE GRAPH TO THE WINDOWS CLIPBOARD

To copy the graph to the clipboard, click the  Copy Chart To Clipboard
button.

THE COPY CHART TO CLIPBOARD BUTTON

 The graph is then stored as an image on the windows clipboard and can be
pasted into other applications such as Outlook in HTML format, Word or Excel.

MICROSOFT WORD WITH A GRAPH FROM PROLOG
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WORKING WITH THE DATA IN EXCEL

The View Data In Excel button opens your data in an Excel spread sheet.

 THE VIEW DATA IN EXCEL BUTTON

 If another program is the default viewer for comma separated variable (.csv)
files that program will be used instead. 

CHECKING THE STATUS OF YOUR DATA LOGGER

The status of your data logger can be checked by pressing the Setup button.

THE SETUP BUTTON

 The Setup button displays important information about your data logger that
should be checked every time you are in the field.
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CHECKING THE SUMMARY SCREEN

The Summary tab shows you the most important information about the state
of your data logger.

THE SUMMARY TAB

It  displays  the  site  number,  description,  sampling  rate  as  well  as  current
memory, battery, and clock status.

NOTE: It is important to check the status ofNOTE: It is important to check the status of
the  battery  and  memory  when  you  are  in  thethe  battery  and  memory  when  you  are  in  the
field.field.
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RESTARTING YOUR DATA LOGGER'S RECORDINGS

The Memory tab shows you detailed information about the memory usage of
your data logger. 

THE MEMORY TAB

This tab allows you to restart your data logger and calculate the fill time based
on a restart.  Pressing the  Restart Data Logger button will  restart  your data
logger's recordings.  Always download important information before restarting
the data logger. The Calculate Fill Time Based On Restart button will tell
you when the data logger memory will be full if you were to restart it. You can check
the estimated fill time on the summary tab.
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CHECKING YOUR DATA LOGGER'S BATTERY

The  Battery tab  shows  you  detailed  information  about  the  data  logger’s
batteries. 

THE BATTERY TAB

This screen also allows you to set your data logger's sensors for  Pulsed or
Continuous power. Some sensors require a certain amount of time to stabilize to a
correct reading. In Pulsed power mode the data logger powers your sensor for the
specified  warm-up  time,  takes  a  reading  and  then  goes  back  to  sleep.  With
Continuous power mode the sensor has power delivered to it constantly.

NOTE: Powering your sensors continuouslyNOTE: Powering your sensors continuously
may  consume  much  more  power  and  couldmay  consume  much  more  power  and  could
inadvertently drain the battery if left on.inadvertently drain the battery if left on.
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SETTING THE DATA LOGGER'S CLOCK

The Clock tab allows you to check and set the data logger clock.

THE CLOCK TAB

The Set Data Logger Clock button will let you synchronize the clock of
your data logger to your computer’s time or let you specify a different value.
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CHECKING  AND  LEAVING  NOTES  ABOUT  THE  SITE  IN
THE DATA LOGGER

The  Notepad button displays a section of the data logger’s memory where
you can store information in text form. 

THE NOTEPAD BUTTON

THE NOTEPAD SCREEN

The  New, Open And Save Notepad buttons are able to create a new
notepad, load a notepad file that you have saved on your computer, or save a file
containing the notepad information to your computer.

NEW, OPEN, AND SAVE BUTTONS

The  Read From Logger button reads the notepad from the data logger’s
memory and displays the information on the screen.

The  Write To Logger button  writes the  text  on the screen into  the  data
logger's memory.
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CHECKING THE SENSORS

The  Sensors button  will  allow you  to  monitor  readings and change  which
sensors are being used in your application. 

THE SENSORS BUTTON

THE SENSORS SECTION
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The Start Monitoring button shows the current readings of your sensors.

THE START MONITORING BUTTON

  The sensor readings are calculated differently depending on what sensor is
selected for the channel. The sensor selection drop down menu lets you choose
which sensor is on each channel. Changing a sensor using the drop-down menu
also updates your graph in the data section.

THE SENSOR SELECTION DROP DOWN MENU

Prolog  saves  the  information about  which  sensor  is  on  each  channel  in  a
sensor format file. The New, Open And Save Sensor Format File buttons
give you the capability to create a new sensor format, load a sensor format file that
you have previously saved on your computer or save a sensor format file to your
computer respectively.

THE NEW, OPEN AND SAVE SENSOR FORMAT FILE BUTTONS

NOTE: If there is a sensor format file in yourNOTE: If there is a sensor format file in your
project with the same name as the data loggerproject with the same name as the data logger
description  Prolog  will  automatically  load  itdescription  Prolog  will  automatically  load  it
unless the Automatically load sensorunless the Automatically load sensor  file checkfile check
box is unchecked.box is unchecked.
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CHANGING YOUR DATA LOGGER'S CONFIGURATION

The Programming tab displays the current settings that are programmed in
your data logger. This section will allow you to change the site number, description,
warm-up time and sampling rate. Inputs (sensors) can also be turned on or off in this
screen. You can change any of these settings and then apply them to your data
logger by pressing the Program Data Logger button. 

THE PROGRAMMING TAB
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The New, Open And Save Logger Configuration buttons allow you to
create a new data logger program, load a program or save a program.

THE NEW, OPEN AND SAVE PROGRAMMING BUTTONS

The Program Data Logger button sends new settings to your data logger
that you have modified. 

THE PROGRAM DATA LOGGER BUTTON

NOTE:  Pressing  the  program  data  loggerNOTE:  Pressing  the  program  data  logger
button will restart the unit's memory. button will restart the unit's memory. 
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The  recording  rate  of  your  data  logger  can  be  changed  by  changing  the
numbers of the sample rate. If you change the sample rate it is important to check
the new memory fill time by pressing the Calculate Fill Time button.

THE CALCULATE FILL TIME BUTTON

You may have to change the memory size drop down box on the calculate
fill time form to correspond to the memory size of your data logger.

THE CALCULATE FILL TIME FORM

THE MEMORY SIZE SELECTION
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WHERE TO FIND MORE INFORMATION

You may obtain more information by using either the built-in Help files or by
contacting Lakewood Systems directly.

ACCESSING THE HELP FILES

The Help files can be  accessed by selecting Help from the Help menu of the
program.  The  help  files  contain  detailed  information  that  is  not  covered  in  this
getting started guide.

OBTAINING TECHNICAL SUPPORT

Technical support can be obtained by contacting Lakewood Systems directly.
Please feel free to contact us if you have any questions or concerns. The following
contact information can be used to obtain technical support:

Tel.: (780) 462-9110
Fax: (780) 450-3867
#112, 9704 39 Avenue
Edmonton AB
Canada
T6E 6M7
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